eForm User Guide
How to complete & submit the eForm

YOUTH IN ACTION 2007-2013
Deadlines:
Sub-programme / Action /
Sub-action

Deadlines
for
submission

Description

Youth for Europe

Round 1
01/02/2013
12:00
midday

Action 1.1

Youth Exchanges

Action 1.3

Youth Democracy

Youth in the World

Cooperation with Neighbouring Countries

Action 3.1 TN (1-7)
Action 3.1 TN (8)

Training and Networking (Activities 1 – 7)
Training and Networking (Activities 8)

Action 3.1 YE

Youth Exchanges

Youth Support Systems

Training and networking of those active in
youth work and youth organisations

Action 4.3 (1-7)

Training and Networking (Activities 1 - 7)

Action 4.3 (8)

Training and Networking (Activity 8)

Support for European cooperation in the youth field
Action 5.1

Meetings of young people and those
responsible for youth policy

Round 2
03/06/2013
12:00
midday
Round 3
03/09/2013
12:00
midday
All times
are Brussels
time

EACEA Technical Helpdesk:
Contact Details

Availability
08:30 to 17:30
Monday to Thursday

Tel: +32 229 90705
Email: eacea-helpdesk@ec.europa.eu

08:30 to 17:00
Fridays
Excluding public holidays
All times are Brussels time

Version 1

28 November 2012

[Version 1]

Table of Contents
1
2
3
4

Introduction ........................................................................................................................ 3
Technical Requirements & Considerations ........................................................................ 3
The Online Application Process – Overview ..................................................................... 5
Working with the eForm .................................................................................................... 5
4.1
4.2
4.3
4.4
4.5
4.6
4.7
4.8
4.9

5

Guidance for specific Parts of the form ........................................................................... 11
5.1
5.2
5.3
5.4
5.5

6
7
8

Cover Page ............................................................................................................................ 11
Parts A and B – Organisations.............................................................................................. 12
Part C – Description of the Project ....................................................................................... 13
Part E – Project implementation / Award criteria ................................................................ 14
Part F – Participants in the project ...................................................................................... 15

Attaching Documents to your eForm ............................................................................... 16
Validation of your eForm ................................................................................................. 18
Submission of your eForm ............................................................................................... 20
8.1
8.2
8.3

9
10

Download the eForm from EACEA ......................................................................................... 5
Adobe Reader – a brief introduction to some key features of the pdf form ............................. 5
eForm completion.................................................................................................................... 7
Mandatory, optional and calculated fields .............................................................................. 8
Saving your form ..................................................................................................................... 9
Entering Dates and Numbers .................................................................................................. 9
Using the Add and Delete buttons (eForm tables) .................................................................. 9
Formatting ............................................................................................................................. 10
Character Limits.................................................................................................................... 10

The mandatory save BEFORE submission ............................................................................ 20
Submission ............................................................................................................................. 21
The mandatory save AFTER submission ............................................................................... 22

Printing your eForm ......................................................................................................... 23
How to obtain Technical assistance – EACEA Technical HelpDesk .............................. 23

Page 2 of 24

[Version 1]

1

Introduction

Applications for the Actions of the Youth in Action programme listed on page 1 of this guide must be
made using the eForm.
The purpose of this document is to provide guidance on the technical aspects of completing and
submitting the eForm. It does not replace the Programme Guide which must be read and consulted by
applicants for all guidance on the content of the application form, the application procedure and the
rules that must be respected. This document can be found on the relevant webpage:
http://eacea.ec.europa.eu/youth/programme/programme_guide_en.php
Please note that the terms 'eForm', 'form', 'application form' and 'online application form' are used
interchangeably throughout this guide.
You are strongly advised not to leave the preparation and submission of your application form until
the last days before the deadline for applications

Please read all of this User Guide before beginning your application

2

Technical Requirements & Considerations

The eForm is an interactive PDF form that requires Adobe Reader software to be installed on your
computer for you to be able to complete and submit it.
The retrieval and submission of the form are ‘online’ activities but completion of the form and its
validation are ‘offline’ activities. This is explained in more detail in the process overview below.
Adobe Reader
The minimum version i.e. lowest version of Adobe Reader that you must have installed on your
computer is version 8.1.5. You may also use a higher version than this e.g. 9.0, 9.1, X, XI etc. If you
have a lower version than 8.1.5, you will not be able to complete and submit the eForm.
Follow the link below to be directed to Adobe's website to download the software free of charge or to
upgrade your existing copy of the software. If you do not have administrator rights on your computer
this activity may require the intervention of your IT department. You will need to specify your
operating system before the download can commence.
http://get.adobe.com/reader/otherversions/
If you are using Adobe Acrobat (Standard) or Adobe Acrobat Professional, the version must likewise
be 8.1.5 or higher.
The screenshots in this User Guide are based on version 8.1.6 of Adobe Reader.
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You can check the system requirements for Adobe Reader – i.e. the minimum required specification of
your computer – through the following link:
http://www.adobe.com/uk/products/reader/systemreqs/
Security settings in most versions of Adobe Reader and Adobe Acrobat
If you are using a version of Adobe Reader or Adobe Acrobat that incorporates Enhanced Security, it
is very likely that the enhanced security settings will block the submission of your eForm. The
involved versions of Adobe Reader and Adobe Acrobat are:


8.2 or any higher version 8 than this (including any sub-versions e.g. 8.2.1, 8.2.2 etc);



9.3 or any higher version 9 than this (and including any sub-versions e.g. 9.3.1, 9.4.2 etc);



any version X (including any sub-versions e.g. 10.0.1);



any version or sub-version higher than version X e.g. version XI.

The disabling of the Enhanced Security is performed from the following Adobe Reader menu path:
Edit > Preferences > Security (Enhanced)
Uncheck the box Enable Enhanced Security and click OK. Once the submission has been performed
you can re-enable the Enhanced Security. For more detailed instructions (including screenshots),
please refer to the relevant 'Known Issue' on the following webpage:
http://eacea.ec.europa.eu/eforms/index_en.php#issues
Here you will also find instructions on how to leave Enhanced Security generally enabled but identify
your eForm as a trusted item (stored in a ‘privileged location’) so that its submission is not blocked.
Internet Connection & Browser software
You will require an internet connection and standard browser software to retrieve and submit the
online application form.
Test eForm
A test eForm is available on the EACEA eForm home page:
http://eacea.ec.europa.eu/eforms/index_en.php
The form contains a small number of questions and functions. It has been designed to help applicants
understand how the main fields in the eForm work and also to ensure that their own software and
internet connection allow an application form to be submitted. It is NOT mandatory to use this form; it
is provided as a help tool for applicants who are using electronic submission for the first time.
Advice for Macintosh Users
The eForm can only be opened and completed using Adobe Reader or one of the Adobe Acrobat
products. It is not possible to open and work with the eForm using the Mac Preview viewer.
Please therefore ensure that if your default viewer is set as Mac Preview, you nonetheless open the
eForm with one of the Adobe products mentioned above. This advice applies to both the download of
the form – if you try to open it before downloading – and to the opening of the form for its general
completion and submission. For more detailed advice, please visit the ‘Known Issues’ section of the
EACEA eForm home page:
http://eacea.ec.europa.eu/eforms/index_en.php#issues
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The Online Application Process – Overview

3
(i)

(ii)

(iii)
(iv)

(v)
(vi)
(vii)

4
4.1

You download the eForm from the agency website, saving it to your own computer or local
network drive. Do not try to fill in the form directly on the website. The form can only be
filled in once you have saved it to your local computing environment.
You complete the eForm on your own computer (as an ‘offline’ document). You do not need
to be connected to the internet for this and no connection to the EACEA website or any
Commission server is required. Completion of the form includes the attachment of the
annexes.
You validate the form (on your own computer) to ensure that it is ready for submission.
You connect to the internet and press the submit button to submit your form. You do not need
to be connected to the EACEA website or to any particular webpage – this connection to the
Agency’s server happens automatically. (The submission process includes a mandatory save
both before and after the submission. These save operations are instigated by the form itself.
This is explained in detail in section 8.)
If the submission is successful, a submission number will be automatically generated and
added to your form.
You print your form.
An email acknowledging receipt of your form is automatically sent to the email address that
you entered for the contact person of the Applicant Organisation (Part A.2).

Working with the eForm
Download the eForm from EACEA

A link to a read-only copy of the form can be found on the EACEA eForm home page:
http://eacea.ec.europa.eu/eforms/index_en.php
Save the form to your local computer or network drive.
You can now open, save, close, print etc the file in the same way you would any other document you
had saved or created on your own computer.
4.2

Adobe Reader – a brief introduction to some key features of the pdf form

Activate
Page Thumbnails
(see below)

Activate the
Highlight Fields
facility

VERY
USEFUL!

Attach facility

DO NOT USE!

Adobe Help for
common features

The eForm has its
own attach facility
Navigation panel,
on the left-hand
side of the screen
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Toolbar
From the Tools menu you can customise your toolbar e.g. you can add the Save button if it is not
already displayed. There are also various display and navigation options that you can add.

Toolbar

Customise
toolbar
selection
menu
(partial view)

Explained here are some of the commonly used display and navigation options:
Move
back 1
page

Move
forward 1
page

Fit form to width
of screen and scroll
across page
boundaries

Zoom In
(reduce
image size)

Zoom Out
(enlarge
image size)
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Page Thumbnails
If you activate the Page Thumbnails option, a new panel is opened up on the lefthand side of the
screen. It contains miniature previews (‘thumbnails’) of each page:

Red box
indicating
your
location



Use the
thumbnails to
jump to different
areas of the form.



A box outlined in
red indicates
where you are in
the document.



Right click on the
panel to access
options to enlarge
or reduce the
thumbnails.

Zoom in / Zoom out
To rapidly zoom in or out, press CTRL on your keyboard and move the scroll wheel on your mouse:
Scroll up
Scroll down
4.3

to zoom out, increasing the size of the image
to zoom in, decreasing the size of the image

eForm completion

The eForm is an interactive PDF form that contains form fields that are either selected from a
restricted list or filled in using free text:
Click inside a text field to enter data.
Click to select options from e.g. dropdown menus, radio buttons, pop-up calendars and
checkboxes.
Press Tab to move forward one field or Shift+Tab to move backward one field.
Point and click with the mouse to select a specific field.
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4.4

Mandatory, optional and calculated fields
Field Type

Characteristics

Mandatory

Field label is
accompanied by an
asterisk *

Optional

Calculated
automatically

Examples

Field label has no
asterisk
Field contains
diagonal grey lines.

How to highlight mandatory fields
Click on the purple button
in the navigation panel and this will activate the Document message
bar which incorporates the Highlight Fields feature.
Click on the Highlight Fields button and all
mandatory and optional fields will gain
highlighting that makes them easier to identify
(and easier to differentiate from one another).
Mandatory fields – red border and a light blue background
Optional fields – light blue background (and a black border when you hover the cursor over them).
Highlighted fields

Unhighlighted fields

Please note: if any mandatory field remains incomplete the eForm will not validate successfully and it
will not be possible to submit your form. Where a numerical field is mandatory but you have no value
to enter e.g. in table C.5, please make sure you enter a zero to indicate your null value.
Once you have activated the highlighting you can click the purple button
Document message bar (and maximise the display of your form).
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4.5

Saving your form

To save your form, click on the Save button on the toolbar or select Save from the File menu or press
CTRL and S.

Please ensure that you save your form on a regular basis. If you encounter a problem in your local
computing environment and your form or your computer crashes, the Adobe Reader auto-recovery
function will only restore your form to the point of the most recent save.
4.6

Entering Dates and Numbers

Please respect the following rules when entering dates and numbers on the form:
Rule

Example

Numbers

Use decimal points not decimal commas.

Dates

All date fields are in the format
dd/mm/yyyy

01/10/2011 for 1st October 2011

Telephone numbers

No rules - this is a free text field

-

4.7

50.75 for fifty euros and
seventy-five cents

Using the Add and Delete buttons (eForm tables)

Some fields or groups / blocks of fields are required to be completed more than once allowing you to
build up a 'table' of information e.g. the list of organisations involved in your project. Whenever you
need to insert a new 'blank' field or add rows to a table, you will do this by using the Add buttons.
These buttons are coloured green. Click on them to add the desired new field or table row.
Click here
to add a new
row
Click here to
delete a row

Once you have added a field or row, the delete facility – an orange-coloured button containing an 'x' –
appears so that you can delete the field, block of fields or table row concerned (and its contents!).
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4.8

Formatting

If you enter formatted content into the form e.g. through copy-and-paste from other document sources,
the eForm will strip off the formatting and plain text only will be pasted into the form.
Please do not copy bullet points into your form. The formatting of some bullets can trigger the
requirement to download add-ons to your Adobe Reader software (so that it can handle those bullets).
You may use dashes to represent bullets in a list of points or items.
4.9

Character Limits

The free text fields in the eForm have character limits that restrict the amount of text you can enter.
These limits include both characters AND spaces. If you try to enter more characters than the limit
allows the form will simply restrict the text to the predefined limit. Many word processing packages
have a 'count' tool that can help you respect the limits.
For the major fields, the limits are displayed in the headings and sub-headings of the eForm. For other
fields, please consult the following table:
Part

Field
Project Title

Character Limit
50

Project Acronym (see section 5.1)

7

Full name of the organisation

62

Name in latin characters

62

Acronym

62

Department / Faculty

60

Street

57

Street Number

5

Postcode

12

Town

60

Internet address

62

Telephone 1 and Telephone 2

60

Fax

60

Family name

62

First name

62

E-mail

100

Role in the organisation (A.2 and A.3)

32

Programme or Initiative

25

Reference number

15

Beneficiary organisation

25

Title of the Project

25

Programme concerned

25

F.1

Name of the promoter

62

F.2

Promoter

62

Promoter

62

Profile of participants

100

Promoter

62

Role of expert(s)

100

Promoter

62

A
(and F.6)

B.3

F.7
F.8
F.9
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5
5.1

Guidance for specific Parts of the form
Cover Page
Important!
Please ensure that you complete all the fields of the Cover Page (page 1) before going on to
complete the rest of the form!
This is because the selections that you make on this page, dictate how the rest of the form
appears and behaves. For example, the options that are available in Part C.2, Type of Activity
are dependent upon the sub-programme and action that you selected.
Information concerning the deadlines for submission
Please be aware of the following constraints:


Applications may only be submitted for the next scheduled deadline – the online system
blocks the submission of applications that are for a deadline that is not the next scheduled
deadline.



Once a deadline has passed, there is a gap in time before the online submission system is
re-opened for the next scheduled deadline. Here are the details of when the online
submission system is opened for each deadline:
o

Round 1 deadline 01/02/2013 – Submission was opened when the eForm was
published;

o

Round 2 deadline 03/06/2013 – Submission open from 01/03/2013;

o

Round 3 deadline 03/09/2013 – Submission open from 01/07/2013.



If you attempt the submission having selected a deadline that is not the next scheduled
deadline OR when the online submission system is closed, the submission of your form
will be blocked and it will not take place. Nevertheless, it will still be possible for you to
submit that same form once the submission has been opened for the deadline you are
interested in. Be aware, however, that the submission process will have locked your form
so you will no longer be able to modify its content or change the attachments.



It is not possible to submit an application for a deadline that has already passed. The
online system blocks such submission attempts.



If you have attempted the submission for a deadline that has passed, it will not be possible
to correct the deadline value (and retry the submission) because the form will be locked.
You would therefore be obliged to start your application again with a new form.

If you are in any doubt about the schedule of deadlines, please check the Youth in Action
Calendar published on the following webpage:
http://eacea.ec.europa.eu/youth/programme/calendar_en.php
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The Project acronym field is limited to 7 characters. If you require an acronym that is longer than this,
please include the full acronym of your project at the start of your Project title and then enter the first
7 characters of the acronym in the Project acronym field.
Parts A and B – Organisations

5.2

For each organisation in your consortium you must complete a part A and a part B. Please note the
following:


P1 is automatically set to have the role of Applicant Organisation. It is not possible to change
this.



For subsequent partners – P2, P3 etc – the role is for you to select:



The field ‘Internet address’ in Part A.1 relates to the organisation’s website address.



The field A.3 – details of the Legal Representative – is only required to be completed for the
Applicant Organisation. Consequently, it only appears in the form for the Applicant
Organisation (P1). For all subsequent organisations, the field A.3 is omitted and only fields
A.1 and A.2 are presented for completion.



The Registered address you enter in Part A.1 is automatically copied to Parts A.2 and A.3.
Check the relevant checkbox in order to write different address details in Parts A.2 or A.3.



Because parts A and B taken together represent the details of a single organisation, the form
‘numbering’ does not follow a ‘pure’ A, B, C, D, E, F but evolves as follows:
A, B, A, B, A, B, A, B, A, B……….C, D, E, F



The Add organisation(s) button has an accompanying field that allows you to add multiple
organisation rows at the same time. These rows are in addition to any that you have already
added. It is recommended that you add your additional organisations in one go.
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As you record your organisation details, a summary table – ‘List of Partner Organisations’ – is
built up automatically in the form:

The table appears after the end of the details of the last partner organisation that you have
entered.
Tips
When selecting a country value, instead of deploying the dropdown menu, enter the initial letter of the
country into the field. This will take you to the first country in the list that begins with that letter. Press
the same letter again to bring up the next country. For example, entering the letter ‘c’ three times in
succession would bring up:
then
then

Cyprus
Czech Republic
Croatia.

The up and down arrow keys on the keyboard can also be used to navigate the list – without deploying
the dropdown menu – once an initial selection has been made.
5.3

Part C – Description of the Project

C.1 Type of Project
This field only appears in the form for Actions 3.1 and 4.3. For all other actions no field C.1 appears in
the form.
C.2 Type of Activity
If you are applying for Action 1.3, this field does not appear in the form.
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5.4

Part E – Project implementation / Award criteria

Where there are checkboxes in this Part, please tick at least one checkbox in each mandatory subsection (E.1, E.2, etc).
The appearance in the form of some of the sub-sections in this Part is dependent upon the Action and,
where relevant, sub-action you are applying under.
The following table indicates the conditions under which the different sub-sections appear or are
hidden. (Where a sub-section is not mentioned in the table, this means that it appears for all Actions.)
Subsection

Display rule

E.3

Does not appear in the form if you are applying under:
 Action 1.3

E.4

Only appears in the form if you are applying under:
 Action 1.3

E.5

Does not appear in the form for any Action

E.7

Does not appear in the form if you are applying under:
 Action 3.1 (Training & Networking sub-actions) or
 Action 4.3.

E.8

Only appears in the form if you are applying under:
 Action 1.1 or
 Action 3.1 Youth Exchanges

E.15

Does not appear in the form if you are applying under:
 Action 3.1 (Training & Networking sub-actions) or
 Action 4.3
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5.5

Part F – Participants in the project

The appearance in the form of some of the sub-sections in this Part is dependent upon the Action and,
where relevant, sub-action you are applying under.
The following table indicates the conditions under which the different sub-sections appear or are
hidden.
Subsection

Display rule

F.1

Only appears in the form if you are applying under:
 Action 1.1 or
 Action 1.3 or
 Action 3.1 Youth Exchanges or
 Action 5.1

F.2

Only appears in the form if you are applying under:
 Action 1.1 or
 Action 3.1 Youth Exchanges

F.3

Only appears in the form if you are applying under:
 Action 1.3 or
 Action 5.1

F.4

Does not appear in the form for any action

F.5

Does not appear in the form for any action

F.6

Does not appear in the form for any action

F.7

Only appears in the form if you are applying under:
 Action 3.1 (Training & Networking sub-actions) or
 Action 4.3

F.8

Only appears in the form if you are applying under:
 Action 3.1 (Training & Networking sub-actions) or
 Action 4.3

F.9

Only appears in the form if you are applying under:
 Action 3.1 (Training & Networking sub-actions) or
 Action 4.3
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6

Attaching Documents to your eForm

The following mandatory annexes, which are a formal part of your grant application, must be attached
to your eForm:



Declaration on Honour;
Workplan / daily timetable and budget.

Please use the following filenames for your attachments and respect the cited format restrictions:
Annex Filename

Required Format

Declaration of Honour

.pdf, .jpg or .jpeg

Workplan / daily timetable and budget

.xls, .xlsx

Attachment size limitation
There is a limit to the total (combined) size of your attachments. This is 5MB. If you receive a
message advising you that the total size of documents exceeds the maximum allowed, please reduce
the size of the image-based documents e.g. by reducing their resolution.
To carry out the attach function, click on the relevant Attach a document button and a window will
pop up enabling you to browse, locate and select the file you wish to attach:

Click on the ‘Open’
button to attach the
selected file to your
application.

Once a file has been successfully attached, the filename is displayed and the Attach a document
button is replaced by a Delete this document button and a View this document button:
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Viewing attached documents
You may encounter the following information message when trying to view non-PDF documents that
you have attached:

If so, you can change your settings – to allow such documents to be opened – via the following Adobe
Reader menu path:
Edit > Preferences > Trust Manager
Check the box Allow opening of non-PDF file attachments with external applications and then click
OK to confirm the setting change:
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7

Validation of your eForm

The Validate Form button appears at the bottom right of every page of the form.

It is recommended that you do not validate your form until you have finished completing it as
validation slightly alters the look of the form.
When you are ready, click on the button and various checks will be automatically performed to
ascertain whether your form is ready for submission. For example, the validation will verify that all
mandatory fields have been completed, that no rules have been broken in the budget table and that all
the mandatory attachments are present.
If there are any errors present, the total number of them will be listed on the last page of your form. If
there are any budget or attachment errors these will be itemised separately in the same list:

The errors themselves will be highlighted in pink. In the example that follows the mandatory field
‘Summary of the Project’ has not been completed:
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When you validate, an additional button – the Go to Next Error button – appears next to the Validate
form button.

Use this button to jump from error to error in your form. The function starts with the error nearest the
top of the form i.e. nearest to Page 1 and descends the form moving to the next error with each click.
Please note the following:


When you fix the errors that are highlighted, the Errors list is not dynamically updated. It is
only updated i.e. refreshed when you perform another validation.



The Go to Next Error function works best when you fix errors one by one, following the topto-bottom sequence used by the Go to Next Error button. If you fix errors out of sequence
e.g. fix an error further down the form, the Go to Next Error function will still follow the
original sequence of errors reported by the validation.



If you have fixed errors out of sequence, you are recommended to perform a fresh validation
so that the errors you have fixed are removed from the sequence (and you would then start
again from the error nearest the top of the form).



If you prefer, you can simply do a visual search for the pink errors in your form. If you do
this, it is recommended that you first turn off the highlighting for mandatory fields (see
Section 4.4). You may find the thumbnail view a useful aid to quickly detecting the pink
highlighted fields (see Section 4.2).

Whichever method you use, fix the errors that are present and validate your form again. If all errors
have been resolved you will see the following pop-up message:

Until your form validates successfully the Submit button is disabled and it will not be possible to
submit your form. The Submit button turns from grey to green when validation has been carried out
successfully.
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8

Submission of your eForm

On the final page of the form is the Submit this form button. Once your form has been successfully
validated the button is enabled (as confirmed by its green colour). Click on this button to launch the
submission. Before proceeding with the submission, please ensure you have consulted and, where
necessary, followed the advice on Adobe security settings found in section 2 of this user guide.

The following message will appear:

If for any reason you do not want to continue, you may click No and carry out the submission at a later
time. The submission process will end. Once you click Yes your form will be locked and it will no
longer be possible to modify its content or change the attachments.
Should you encounter any error messages during the submission of your form, please refer in the first
place to the ‘Known Issues’ section of the eForm home page:
http://eacea.ec.europa.eu/eforms/index_en.php#issues
8.1

The mandatory save BEFORE submission

If you click Yes, the next step of the submission process is a mandatory save. The following message
appears:

When you click OK, the form triggers a Save As operation. You will see the classic Save As window as
appears in the screenshot which follows.
(Please note: this screenshot is simply an example of the Save As window. The window that you see,
will reflect the filename and directory name that you have been using.)
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Example screenshot

You must now perform the Save As by clicking on the Save button.
Very Important!
You must NOT change the filename of your eForm.
You must keep the same filename that the file had when you began the submission operation!
Click Yes when you are asked if you want to replace the existing file:

8.2

Submission

Depending upon your security settings, the following pop-up window may now appear:
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If the window appears, click on the Allow button in order to proceed with the submission.
When the submission is complete you will see a pop-up message similar to the one that follows:

Click ‘OK’.
8.3

The mandatory save AFTER submission

When you click OK, the form triggers another Save As operation. This is so that you cannot
mistakenly close the form without saving (and so lose the submission number).
Once again you will see the classic Save As window appear:

Example screenshot

You must now perform the Save As by clicking on the Save button.
Very Important!
You must NOT change the filename of your eForm.
You must keep the same filename that the file had when you began the submission operation!
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Click Yes when you are asked if you want to replace the existing file:

When you click ‘Yes’, the submission number is automatically added to the ‘Submission number’
box:

It is also inserted into the footer of your form.
The form has also been saved and this save included the submission number.
Your submitted form is now ‘locked’. That is to say, it has been converted to a read-only document:
changes cannot be made to it and it cannot be re-submitted.
As part of the submission process, an email message acknowledging receipt of your eForm is
automatically sent to the email address you entered for the contact person of the Applicant
Organisation (Part A.2).
As indicated by the earlier pop-up message, you may now print the form before closing it.
Please consult the relevant funding opportunities webpage for details of the documents that must be
submitted by post to the Agency.

9

Printing your eForm

The eForm can be printed using Adobe Reader’s standard menu-driven print function. The Print
button is found on the tool bar, or the Print menu can be selected from the File menu.

10 How to obtain Technical assistance – EACEA Technical HelpDesk
If this User Guide does not provide answers to all of the technical questions or problems you
encounter in completing the application form, a telephone and email HelpDesk service is available to
assist you further:
EACEA Technical HelpDesk: +32 229 90705
eacea-helpdesk@ec.europa.eu
Monday to Thursday 08:30 to 17:30
Fridays 08:30 to 17:00
Excluding public holidays
All times are Brussels time
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Should you experience what you believe to be a significant technical issue with the eForm it will be
worth checking the Youth in Action website since, in the event of a general technical problem, an
update bulletin would be posted.
You may also visit the Agency’s dedicated eForm webpage which contains the latest versions of all
published forms along with a Test eForm and other items of information:

http://eacea.ec.europa.eu/eforms/index_en.php
Non-technical assistance
If you require assistance with a query or problem that is not technical in nature, please do not contact
the EACEA Technical Helpdesk. This Helpdesk team are only authorised and trained to help
applicants who are encountering technical problems.
Please refer instead to the funding opportunities webpage of the programme/action that you are
applying for. On this webpage you will find details of how to obtain non-technical assistance e.g.
assistance with questions on:




the content of the eForm;
the application procedure including details of the documents to be submitted by post;
the rules of the programme / Call that you are applying for.

Generally speaking, the funding opportunities webpage will include the mailbox address of the
programme team that is responsible for the programme/action that you are applying for. The page will
also contain documentation that may already provide an answer to your non-technical question e.g. an
Application Guidelines or Instructions for Applicants document or a link to an in-country Helpdesk
which can help you. If you cannot find the answer to your question, please contact the mailbox of the
programme team cited on the funding opportunities webpage.
The following table provides some examples of technical and non-technical questions.
Technical Questions
(handled by the EACEA Technical Helpdesk)

Non-technical Questions
(handled by the programme team)

I can’t download the form.

What is required to be entered for the field Other
Community Grants?

A dropdown list isn’t working.

Why isn’t country A in the dropdown list?

I can’t attach my budget form (or
other annexe/attachment).

I need help with completing my budget form.

How does the synchronisation of fields work?

Why is this field mandatory?

I can’t delete a table row that I have entered.

Our project has more than one coordinator.
What should I do?
What is the minimum / maximum number of partners that
is allowed?

My form freezes/crashes.

What documents are required to be sent to the Agency by
post and where do I send them?

My form is working slowly.

I need more characters for my answer!

My form won’t validate.

What do you mean by the term ‘acronym’?

My form won’t submit.

Where are the templates for the attachments and
additional documents?

I think there is a bug in the form.

What should I enter in the form for my project start and
end dates?
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